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1. Pressing the _______ key will take a snapshot of everything that is
displayed on your monitor screen.
 _______ की दबाने  से  आपकी मॉनिटर स्क्रीन पर प्रदर्शित होने  वाली सभी चीजों  का
एक स्नैपशॉट में ले लिया जाएगा ।

*
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/usr/mydir

Usr\mydir

Mydir/usr

/mydir/usr
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View

Table

Tools

Format

1/1

Track

Oval

Sector

Disk area

2. In Linux, a sub directory 'mydir' of the directory 'usr' will be
represented as:  
लिनक्स (Linux) में डायरेक्टरी ‘usr’ की सब-डायरेक्टरी 'mydir' को किस रूप में 
दर्शाया जाएगा ?

*

3. By using which tab can you convert a table to plain text in an
OpenOffice writer?  
ओपन ऑफिस राइटर (open office writer) में किस  टैब का उपयोग करके  आप 
टेबल के   कं टेंट को सामान्य टेक्स्ट में बदल सकते हैं?

*

4. A ______ on a disk is the one of the many circular ring shaped areas
where data is written magnetically
 डिस्क पर बहुत सी वृत्ताकार आकृ तियों वाला वह  क्षेत्र जहां पर  डेटा को  चुंबकीय रूप
से  लिखा जाता  है, ______ कहलाता है।

*
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720 x 480 pixels

1920 x 1080 pixels

680 x 440 pixels

1020 x 950 pixels

1/1

Mechinacal platters

Flash memory chips

Magnetic taps

Magnetic glass

1/1

Vaccum tubes

Integrated circuits

Transistors

Silicon computer chips

5. What is the resolution of normal Blu-ray high definition? 
 सामान्य ब्लू-रे  हाई  डेफिनिशन का रिजोल्यूशन कितना होता  है?

*

6. Solid State Drive stores data in a __________..
 सॉलिड  स्टेट ड्रा इव डेटा को __________ में  स्टोर करता है।

*

7. Which of the following is used for processing in the second
generation of computers? 
 द्वितीय पीढ़ी के  कं प्यूटरों में प्रोसेसिंग के  लिए निम्न में से किसका उपयोग किया गया था ?

*
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Velocity of the big data

Variety of the big data

Veracity of the big data

Volume of the big data

1/1

100 Meters

10 meters

1 meters

300 Meters

1/1

Pascal

Neumann

Holerith

Niklaus Writh

8. In Big Data, the speed with which data is generated is called
_____________. 
 बिग  डेटा में  जिस गति से  डेटा का उत्पादन होता  है, वह गति क्या कहलाती  है?

*

9. What is the operating range of class 1 Bluetooth devices?  
क्लास 1 ब्लूटू थ डिवाइस की ऑपरे टिंग रेंज क्या है?

*

10. Pascal language was invented by:  
पास्कल लैंग्वेज का आविष्कार किसके  द्वारा किया गया था ?

*
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Intel

Samsung

Microsoft

Apple

1/1

Integrity test

Power-on self-test

Software

Reliability test
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NTFS

EXT4

FAT32

EXT1

11. Accelerated Graphics Port or AGP have been developed by ______.  
एक्सेलरेटेड ग्राफ़िक्स पोर्ट  या AGP _______ द्वारा विकसित किया गया है।

*

12. When the computer is switched on, which of the following tests does
the booting process perform?  
कं प्यूटर के  चालू होने पर, बूटिंग प्रक्रिया कौन से टेस्ट को करना  शुरू कर देती है?

*

13. Which of the following file systems is supported by Windows 98?  
निम्न में से कौनसा फ़ाइल सिस्टम Windows 98 द्वारा समर्थित  है?

*
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Keyboard

Joysticks

Webcam

Wii remote

1/1

(i)-TRUE, (ii)-FALSE

(i)-TRUE, (ii)-TRUE

(i)-FALSE, (ii)-FALSE

(i)-FALSE, (ii)-TRUE

1/1

CPU

Modem

DSL

ISDN

14. Which of the following is a visual input device?
 निम्नलिखित में से कौनसा एक विजुअल इनपुट डिवाइस है?

*

15. Which of the following options gives the truthfulness of given
statements?(i) A digitizer converts signals into numeric values stored in a
computer(ii) OCR is a device commonly present in banks as they deal
with many cheques every day. 
 निम्नलिखित में से कौन सा विकल्प दिए गए कथनों  की सत्यता बताता  है?(i) एक
डिजिटाइज़र  कं प्यूटर में संके तों  को संग्रहीत  संख्यात्मक मानों (numeric values)में
परिवर्तित करता  है।(ii) OCR एक ऐसा उपकरण है जो आमतौर पर बैंकों में उपलब्ध
होता है , जो प्रत्येक दिवस कई चेकों से  संबंधित कार्य करता  है।

*

16. Which of the following is NOT a method of accessing the web?  
निम्नलिखित में से कौन सा वेब तक पहुंचने का एक तरीका नहीं  है?

*
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Non-impact

Impact

Dot-matrix

Daisy-wheel
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When you wish to finish your work and want break from your work.

When your computer is tired

When your computer is not halting since long time.

When you want to come back to work a short break

1/1

Satellite

Coaxial cable

Internet service provider

Modem

17. In ______ printers, printing head does NOT touch the paper? 
 ______  प्रिंटरों में, प्रिंटिंग हेड कागज़ को स्पर्श नहीं  
करता है।

*

18. When do you prefer to select sleep mode of your computer?  
आप अपने  कं प्यूटर में स्लीप मोड के  चयन को कब वरीयता देंगे ?

*

19. Which of the following performs the operation like modulation and
demodulation?  
निम्नलिखित में से क्या मोड्युलेशन और डिमोड्यूलेशन जैसे  कार्य  करता है?

*
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Short

Long

Extremely long

Very long

1/1

Double the RAM capacity

Remove the hard disk and install it to other computer to take file backup

Install new file system

Format the hard disk

1/1

Sound card

VGA card

Network interface card

Expansion card

20. In hotspot, the access point shares the signal over ______ distance.  
हॉटस्पॉट में, एक्सेस पॉइंट सिग्नल को ______ दू री पर साझा करता है।

*

21. When the computer system is corrupted and CANNOT load the OS,
what is the best way to recover the files stored in that computer?  
जब कं प्यूटर सिस्टम करप्ट हो जाता  है और OS लोड नहीं  कर सकता  है तो उस  कं प्यूटर
में स्टोर्ड/संग्रहीत फ़ाइलों को पुनर्प्राप्त करने  का सबसे अच्छा तरीका क्या  है?

*

22. You want to connect your computer to another computer over a
network. Referring to the given scenario, identify the name of the card
that youwill require.   
आप एक  नेटवर्क  पर अपने  कं प्यूटर को दू सरे   कं प्यूटर से कनेक्ट करना चाहते हैं। इस
स्थिति में उस कार्ड के  नाम की पहचान करे  जिसकी आपको आवश्यकता होगी ।

*
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Use

Guide

Restrict

Free

1/1

Email

Browser

FTP

Cookies

1/1

.acrs

.mars

.snp

.ars

23. Access control mechanism in any system is designed to prevent and
______ access to unauthorised users.
 किसी भी सिस्टम  में पहुँच नियंत्रण तंत्र (एक्सेस कं ट्रो ल मैके निज्म ) को अनधिकृ त
उपयोगकर्ता को रोकने  और ______ पहुँच के  लिए डिज़ाइन किया जाता है।

*

24. Pretty good privacy (PGP) is used in ______ security? 
 ______ सिक्योरिटी में प्रीटीगुड प्राइवेवेसी (PGP) का उपयोग किया जाता है।

*

25. Which file format is used to save MS Access report snapshot?  
MS Access रिपोर्ट स्नैपशॉट को सहेजने  के  लिए कौनसे फ़ाइल फॉर्मेट का उपयोग
किया जाता है है?

*
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Impact printer

Non-impact printer

Both impact printer and non-impact printer

Scanner

1/1

Bit rate

Bit decoder

Bit format

Bit encoder

1/1

Laser

Inkjet

Thermal

LED

26. Laser jet printer is a type of? 
लेजर जेट प्रिंटर ______ का एक प्रकार है।

*

27. Most MP3 encoding software allow the user to select the ______
when converting files into the MP3 format? 
अधिकांश MP3 एन्कोडिंग सॉफ़्टवेयर उपयोगकर्ता को फाइल को MP3 फॉर्मेट  में
कनवर्ट  करते  समय ________ का चयन करने की अनुमति  देते हैं।

*

28. Which printer uses heated pins to "burn" images onto heat-sensitive
paper?  
कौन सा  प्रिंटर ऊष्मा -संवेदनशील पेपर पर छवियों को "बनाने" के   लिए गर्म  पिन का
उपयोग करता  है?

*
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Block

Pixel

Frame

Kilobytes

1/1

FAT32

NTFS

ExFAT

FAT

1/1

Browser

E-mail

URL

Network

29. Measurement of picture size or screen resolution is defined as?   
चित्र आकार या स्क्रीन रिजॉल्यूशन के   मापन को किस प्रकार परिभाषित किया जाता है?

*

30. While installing Windows 2000 on a dual-boot workstation with DOS
or Windows Me and if the partition is larger than 2 GB, _______ will
beused.  
डॉस (DOS) या विंडोज एमई (Windows Me) के   साथ डुअल-बूट वर्क स्टेशन पर
विंडोज 2000 स्थापित (इंस्टाल) करते समय और यदि पार्टीशन 2 GB से बड़ा  है, तो
_______ का उपयोग किया जाएगा ।

*

31. Netscape Navigator is a type of ______.  
 नेट्सके प नेविगेटर एक प्रकार का _______  है।

*
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A help facility

An error

A picture

A hyperlink

1/1

HOME

EDIT

FORMATE

INSERT

1/1

Word for windows templates

Auto creation wizard

Template

Presentation wizard

32. On a web page, if your pointer suddenly changes to a hand, what
have you found?  
वेब पेज पर, यदि आपका पॉइंटर अचानक एक हाथ के  आकार में  बदल जाता  है, तो
आपको क्या मिला  है?

*

33. Page break is available in which tab of MS-Word 2016?   
पेज  ब्रेक MS Word 2016  के  किस टैब में उपलब्ध होता है?

*

34. ________ is the quickest way used to create a PowerPoint 2016
presentation?  
PowerPoint 2016 प्रस्तुति करण (प्रेजेंटेशन) बनाने के  लिए उपयोग किया जाने वाला
सबसे तेज़ तरीका ________ है।

*
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Indent markers

Paragraph markers

Auto correct

Drop cap

1/1

Five

Six

Seven

Four

1/1

1

2

3

4

35. MS-Word provides ____________ that allow(s) you to indent
paragraphs to the location you want. 
 MS Word में ________ होते  हैं जिनसे आप किसी  पैराग्राफ को कहीं  पर भी  इंडेंट कर
सकते हैं।

*

36. When I open the drop down list of line spacing in MS-Word 2016, up
to how many spacing options can I see? 
MS Word 2016 में  लाइन स्पेसिंग की ड्रॉ पडाउन लिस्ट को खोलने  पर वहां कितने 
स्पेसिंग विकल्प दिखते हैं?

*

37. The reviewing pane of the Review tab in MS-Word 2019 has _______
number of options in the drop down menu?  
MS-Word 2019 में  रिव्युटैब के  रिव्यूविंग पैन के  ड्रॉ पडाउन  मेनू में विकल्पों की संख्या
______ होती है।

*
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Font

Standard

Status

Paragraph

1/1

Envelopes

Labels

Letter

Greeting card

38. In MS-Word 2013, on which of the following groups of the Home tab
are the alignment options available?
 MS Word 2013 में  होम टैब के  निन्मलिखित में से किस ग्रुप में एलाइनमेंट विकल्प
मौजूद होतेहैं?

*

39. The given icon stands for ________ in the Create group under the
Mailing tab.
मेलिंग टैब के  अंतर्गत 'क्रिएट ग्रुप' में  दिए गए आइकॉन ________ के  लिए उपयोग किये
जाते हैं?

*
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Alt + s

Alt + f5

Alt + p

Alt + c

1/1

NDI

NCPT

NPCI

UTT

1/1

Radar

Line

Surface

Doughnut

40. Which keyboard shortcut key is used to send a mail in MS Outlook?  
MS Outlook में मेल भेजने के  लिए किस कीबोर्ड शार्टकट की का उपयोग किया जाता
है?

*

41.BHIM is a mobile app developed by ______.  
BHIM (भीम) मोबाइल ऐप _________ द्वारा विकसित किया गया है।

*

42. The ___________ chart shows the relationship of the parts to a whole,
but it can contain more than one data series.
 ________ चार्ट कि पूर्ण मद और उसके   हिस्सों के  बीच के  संबंध को व्यक्त करता  है,
लेकिन इसमें आंकड़ों की एकाधिक शृंखलाएं  शामिल हो सकती हैं

*
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Show/hide

View

Breaks

Print preview

1/1

2, 1, 3, 4

2, 1, 4, 3

2, 3, 1, 4

1, 2, 3, 4

43. If Satheesh wants to see where has he added page breaks, he has to
click Home and, in the Paragraph group, click ______.
 यदि सतीश देखना चाहता है  कि उसने पेज ब्रेक कहाँ पर ऐड किया है, तो उसे होम पर
क्लिक करके  पैराग्राफ  ग्रुप में _______ पर क्लिक करना चाहिए।

*

44. Sita wants to delete the conversion of punctation to emojis, which is
done through the AutoCorrect feature of MS-Word 2019. Arrange the
belowsteps in a proper order.1) Select AutoCorrect Options and then
select Replace text as you type.2) Go to File > Options > Proofing3) With
the autocorrect entry highlighted in the list, choose Delete.4) In the
Replace box, type the punctuation.  
सीता विराम चिह्न के  इमोजीस में होने वाले रूपांतरण को हटाना चाहती हैं, जो MS-Word
2019 के  AutoCorrect फीचर के  माध्यम से हो जाते है। नीचे दिए गए चरणों  को उचित
क्रम में व्यवस्थित करें।1) AutoCorrect विकल्प चुनें और फिर Replace text as you
type का चयन करें। 2) File > Options > Proofing पर जाएं   3) सूची में हाइलाइट की
गई स्वत: सुधार (autocorrect) प्रविष्टि  के  साथ, Delete चुनें।  4) Replace बॉक्स में,
विराम चिह्न टाइप करें।

*
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Column breaks

Page breaks

Line breaks

Paragraph breaks

1/1

Use the current document

Start from a template

Start from existing template

Start using current document

1/1

Design form

Tabular form

Outline form

Compact form

45. MS-Word also allows to adjust the columns by adding _____.  
MS Word  में आप ______ ऐड करके  भी कॉलम को एडजस्ट कर सकते हैं।

*

46. To start from a ready-to-use mail merge template that can be
customised according to the needs, the _____ radio button has to be
enabled under'Select starting document' for mail merging the letters?  
एक रेडी -टू -यूज़ मेल मर्ज टेम्प्लेट से शुरू करने के  लिए जिसे  आवश्यकताओं के  अनुसार
कस्टमाइज़ किया जा सकता है, MS-Word 2019 में लेटर्स  के  मेलमर्जिंग हेतु  'सिलेक्ट
स्टार्टिंग डॉक्यूमेंट' के  तहत _____ रे डियो बटन को एनेबल करना होगा ।

*

47. The ______ layout is useful when you want to show all the field names
as heading labels and are not concerned about the width of the pivot
tablebut want to reduce the number of rows in MS-Excel.  
MS-Excel में  _____  ले-आउट तब उपयोगी होता है जब आप सभी फ़ील्ड नामों को
शीर्षक लेबल के  रूप में दिखाना चाहते हैं और  कें द्रीय टेबल की चौड़ाई से आपको कोई
मतलब नहीं   होता है लेकिन आप पंक्तियों की संख्या कम रखना चाहते हैं।

*
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Start menu - > Control Panel ->Date and time

Control Panel - > Start menu -> Data and time

Data and time -> Control Panel -> Start menu

Start menu -> Date and time -> Control Panel

1/1

1

2

3

4

1/1

Click Hyphenation form the page Setup group, insert header or footer

Click the page layout tab, insert header or footer

Open line numbers option, insert header or footer

Insert section breaks, click anywhere in the section of your document insert
header or footer

48. Which of the following sequences can be used to change the system
date and time in Windows 10 operating system? 
Windows 10 ऑपरे टिंग सिस्टम में सिस्टम की डेट और टाइम को बदलने ने  के  लिए
निम्न में से किस अनुक्रम का उपयोग किया जा सकता है?

*

49. How many types of multiple page options are available in the Pages
group of Page Setup in MS-Word 2007?  
MS-Word 2007 में पेज सेट-अप के  पेज ग्रुप में उपलब्ध मल्टीपल पेज विकल्पों की
संख्या कितनी होती है?

*

50. When you need a different header or footer in MS-Word 2010:  
जब आपको MS-Word 2010 में भिन्न शीर्षलेख (header) या पादलेख (footer) की
आवश्यकता हो , तो :

*
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First

Third

Second

Fifth

1/1

History

Settings

Book marks

Downloads

This content is neither created nor endorsed by Google. - Terms of Service - Privacy Policy

Does this form look suspicious? Report

51. In MS-Word 2016, the task of choosing a document from the existing
documents is done in which of the following steps of the mail
mergeprocess?  
MS-Word 2016 में, मौजूदा डोक्युमेंट में से  किसी डोक्युमेंट को  चुनने कार्य मेल मर्ज 
प्रक्रिया के  निम्नलिखित  में  से किस चरण में  किया जाता है?

*

52. Which of the following is a great way to save and organize specific
websites so you can revisit them again and again?  
निम्नलिखित में से कौन-सा , किसी विशिष्ट वेबसाइटों को सेव करने तथा व्यवस्थित करने 
का एक उत्तम तरीका है ताकि आप उन पर बार-बार जा सकें ?
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